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:g™=KEY POINTS

r Microsoft Office Access 2007 1s a member of Microsoft Office 2007 integrated software and it is
the most popular software used worigwide for developing and managing databases

¥ It provides tool for creating tables forms queries and reports that make up a database

¥ In Access. all the nformation of a database in stored in tables since it is a relational database
management system

r Seven types of data types are generally used in Access, which are text, memo, number, auto
number yes/no. currency and datelime

s Sorting feature of Access allow to alphabetically or numencally sort the records in a table in
ascending or descending order

* A form s a tool that makes it easy to enter. delete. modfy and view the information stored in one
Oor more tabies in a database It presents data in an organized and attractive manner

r Query s a tool that answers questions about data 10 select specic information from tables and to
change selecied data in varnous ways It lets you see the data you want and in the order, you
want 1

* Report s a database obiect that crganizes and formats data stored in tables or queries to make it
presentable and meaningful to other people. Reports are used to pnnt data stored in tables and
queries, which is an essental part of using a database

r Columnar report displays each field of a record on a separate line with a label to its left. It spreads
the information for a single record over many rows

# Tabular reponts cisplay fielas of records in a honzontal row with field iabeis at the top of the
report

EXERCISE

Select the best answer for the Tollow g VIC O,
i. Which of the following is used to gather information based on one or more criteria?

A Table B Fom C Query D Report
I, Which data field type is used to provide descriptive comments?
A Text B Memo C Autonumber D. Yes/No
lii. Selecting records in a table which match a given criteria is known as:
A. Sorting data B. Searching data C Updatingcata D Filtenng data
iv. The maximum number of records in a table that can use the Autonumber field is slightly more
tzm; Million B. 1Bilon C 2 Bilkon D. 3 Bilkon
v. Which database object stores all the information of a database?
A Table 8 Form C. Query D. Report
vi. What is the default value of number of characters for Text data type in Access?
A 30 B. 40 C. 50 D. 60
vii. Which query is used to add records from a table to another table?
A. Select query B Update guery C Appendquery D Make Table query
viii. Which query Is used to change data in existing records?
A Select query B Update query C. Appendquery D. Make Table query
ix. In which tab of Access ribbon Relationships icon is located?
A Home B Create C. External Data D Database Tools
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x. In which tab of Access ribbon Query Design icon is located?

A  Home B. Create C External Data D. Database Tools
Answers ' o _ .
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M Short answers of the Tellow ing questions

I. Which tasks can be performed using Microsoft Office Button?
Answer

Tasks performed using Microsoft Office Button
By using Microsoft Office Button following tasks can be performed.
1. Saving

2. Opening
3. New file creation
4. Pnnting

. Describe various ways of deleting records in a table.
Answer

Deleting Records from a Table
The following are the steps for deleting records from a table

1. Open the table from which you wan! to delete record.

2. Select the record you wan! to delete by chcking its row selector box, which is on the left end of the
oW

3. Press the Delete key or chocose Delete from the Records oplion on the Home tab.
4. Click the Yes bution to proceed with the deletion in the dialcg box thal appears.

Ways of deleting records

You can select and delete multiple recorgs by selecting them by clicking the row selector and
dragging it up or dgown and then pressing the Delete key

Once you delete a record and click Yes button 1o confirm your aclion, you will not be able to restore
the record. You cannot undo a record deletion by choosing Undo from the Quick Access Toolbar. If you
ever want to restore a deleted record you will have to re-enter it from the scratch.

One or more columns of a table can be deleted 1n @ similar way as deleting records. Keep 1n mind
the distinction between deieting a row {record) which s all the fields of information about a single entry
and deleting a column for every recerd in the table It s generally easier to re-enter a recerd than a field

for all the records.

When a record in a table s deleted that i1s related to another table, Access might need 10 delele one
or more records in the related table to enforce referential integnty Before doing so it will display a
message At this peint, you must determine whether you want Access 10 delete the additional records.

which you cannot currently see
ili. What are the advantages of using forms?

Answer

Advantages of using forms |
The advantage of using form is presenting data in an organized and attractive manner.

iv. What is meant by referential integrity?

Answer

Referential Integrity
Referential integrity enforcement prevents you from deleting or modifying values of a primary table’s
record on which related records depend
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v. Describe how records can be added and deleted using forms.
Answer

Adding new record using forms

To create a new record, click the New Record button that contains the asterisk on the Toolbar at the
bottom of the form window or click the New Record button in the Records group of Home tab. The new
record will be added o the end of the table and will be displayed in the form window so that you can
enter information into #

Deleting record using forms

To delete a record, first dispiay it in the form window and then choose Delete Record from the

Records group of Home tab nbbon Once you delete a recorc, the data is permanently lost and it
cannot be restored using the Undo command

vi. Describe columnar, tabular and datasheet layouts of forms.,
Answer
Columnar Layout
Columnar layout of form aligns all fiekds in columns.
Tabular Layout
Tabular layout of form creates a form that looks ke a table.
Datasheet Layout
Datasheet layout creates a form that locks like a datasheet.
vil. What is the use of Query Design grid?
Answer
Use of Query Design grid
Query Design grid is used to stores a particular type of data.
viii. What is OpenOffice Base?
Answer
OpenOffice Base
OpenOffice Base 1s the database module of OpenOffice Sute. It 1s an open source application
program OpenOffice Base is a fully featured database management system.

ix, Differentiate between update and append query.

Answer
Difference between update and append query:
rr_......._ . Update Query 1 Append Que |

Update quenes are used to change, add or | Append query is used to add records from @

delete data in exsting records. You cannol | more source table tc a destination table. Very
use an update query to adcd records 10 or | often the source and destination tables are in
delete records from a table but you use It 10 | the same dJdatabase. Append quenes are not
change existing null values to non-nuli values | used 10 change the data i individual fields in |

' and non:null values to null values | existing tables !
x. Differentlate between columnar and tabular reports.
Answer
Difference between columnar and tabular reports.
e s e L altg talx S —
i Columnar report ___ Tabularreports |

Columnar report displays each field of a record | Tabular reports display fields of records in a 5

on a separate ine with a iabel to s left It | honzontal row with field labels at the top of the |
spreads the information for a single record | report.
OVEer many rows.
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). Explain the following database objects.
» Tables

» Forms

» Queries

» Reports
Answer
Tables

Access stores all the information of a database in one or more tables Information stored in tables is
very similar to the Excel worksheet. Information in tables 1s organized in rows anc columns.

Forms
A form 18 a window that is used for viewing. modifying or deleting data that is stored in tables and for
adding new data

Queries
Quenes are used to gather selected informaticn from a database and organize it either for use in
reponts or for viewing on screen A query can combine information from muitiple tables

Reports
Reporis are used for printing information from a database. A report can combine data from more

than one table

ii. Explain the field data types used in Access.
Answer

Data Types in Access
There are seven types of field data types, which are commonly used in Access.
» Text
» Memo

Number

AutoNumber

Yes/NO

Currency

Date/Time

1. Text

Text fields are most common, so Access assigns Text as the default data type. A Text field can
contain as many as 255 characters and you can designate a maximum length less than or equal to 255
Access assigns a defaull length of 50 characters

2. Memo
Memo fields crdinanly contain as many as 65 535 characters. You use them (o provide descriptive
comments. Access displays the contents of Memo fields in a Datasheet view. A memo field cannot be a

key field

3. Number

Vanous numenc data subtypes are available in the Field Properties pane of Table Design window.
Choose the approprate data subtype by selecting one of the Field Tize property settings. You specify
how to dispiay the number by setting its Format property to one of the formats

4. AutoNumber

An AutoNumber field is a numenc (Long Integer) value that Access automatically fills in for each
new record you add 10 a table Access can increment the AutoNumber fieid by 1 for each new record or
fill In the fieid with a randomly generated number. depending on the New Values property setting that
you chcose. The maximum number of records in @ table that can use the AutoNumber field is slightly

more than 2 billion
5. Yes/No

Logical heids in Access use -1 for Yes (True) and O for No (Faise). You use the Format property ¢
display Yes/No fields as Yes or No, True or False, On or Offor -1 or 0.
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6. Currency

Currency s a spec:a! fixed format with four decimal places designed o prevent rounding erross thal
would affect accounting operations where the value must match 10 the penny
7. Date/Time

Dates and times are stored in a special fixed format The whole number portion of the Date/Time
value represents the date anc the time is represented by s decmal fracton. You control how Access
displays dates by selecting one of the Date/Time Format properties
Additional Properties of a Table Field

Depending on the specific data type that you choose for a field, you can set additional propertes for
a table field You set these additional properties on the General page of the Table Design window's
Field Properties pane by selecting from drop-cown or combo lists or by typing values in text boxes
Saving Data in Table

When you haverdefined all the fields that you want 10 include in your table. you must save it. WWhen
you close the Table Design window, it will ask you whether you want 10 save 1t or not. Select save anc
give your table a name You can also save it by chicking the save icon on the top ieft corner of the
screen

i, Describe how forms are created.
Answer

Steps for creating the form
Following are the steps for creating the form shown in Fig 8.24 for the related tables, STUDENT and
RESULT, in Student Database Management System

1. On the Create tab of Access ribbon. click More Forms in the Forms group and select Form Wizard
from the crop-down lisl

2. Select the STUDENT table in the Tables/Queries grop down st i the first dialog box.
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Fig. 8.24 Form for related tables of student database management system

3. Move ali the fields of STUDENT table from the Avaiable Fields list to the Selected Fields hst

using the butions.
4. In the same dialog box, select the RESULT table also anc move all the fields 10 the Selected
Fields list to see them in the sub form and click the Next button

5. The wizard will ask you how you want 10 view your dala Select by STUDENT and also select
Eorm with sub form(s}, which is the default choice and click the Next butten

6. Select the Datasheet layou! for your sub form and click the Next button

Select a style that you like and click the Next button

8. Type the title STUDENT DATA ENTRY FORM for the form and RESULT for the sub form and
click Finish button 1o save il

iv. Write the steps for creating relationships between tables.

r - |
Am;:o connection between a fieid in one table and a field in another table must be defined within |

n
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Access Such a definition 1s known as a relationship and each of the fields is said to be relatgd to the
other field Once a relationship has been designated. Access Can help you maintain the integrity of the
related data and can make it easier l1o access related data. Relationships aiso aliow you 10 create
queries, forms and reports that display information from several tabies at once.

Creating Relationship between STUDENT and RESULT Tables

We are going to create a cne-to-many refationship between the STUDENT table and the RESULT
table This requires that primary key field STUDENTID of the STUDENT table must have a unique
value but the values in the feregn key field, RESULTID can match many enines in the related fieid of
the existing labie to represent results of various examinations Note that the data type for STUDENTID

should be AutoNumber and the data type of RESULTID should also be a number but it can have
dupiicate values

Steps for creating relationship
The steps for crealing relationship between are given below tables .

1. Click the Relationship icon in the ribbon of Database Tools as shown in Fig.8.13
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Fig.8.13 lcon for crealing relationship

2. Chck the STUDENT tabie and click the Add button shown in Fig 8 14

L

i — -

Fig8l4 So Tb! :Iog bo for ing tables
. Click the RESULT table and chck the Add button.
. Click the Clcse butten to close the dialog box.

. Move the mouse pointer 10 the primary key STUDENTID and drag it to the foreign key RESULTID
in the RESULT table.

v. Describe the types of queries that can be created in Access,
Answer |

The following are five types of quenes, thal can be created in Access.
» Select Query
» Updcate Query
» Delete Query
» Append Query
» Make Tabie Query
Creating a Select Query

The following are the steps for creating a Select Query that will display all the re
lable in which the CITY fieid 18 ISLAMABAD. Spay cords of STUDENT

1. Click the Create tab

» W
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2. Click the Query Design icon in the Other group to bring up the query design window.
. Add the STUDENT table and close the Show Table window

4. Double click all the fields cne by one in the box iabeied STUDENT above the query design grid.
The fleld names will appear at the top of each column in the query design grid

5. Enter the crtena ISLAMABAD in the Criteria row in the CITY column as shown in Fig 8.29

I

IRV - STONAME - ALY bce oy
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) AVED 0 A VLAY BUAMARAD
| P IVESMAN o8 L2/ 20 1999 ILANABAD
* [(New|
Fig 829

6. Cick the Save icon above the Access nibbon to save the query. When you are prompted for the
query name, enter STUDENTS LIVING IN ISLAMABAD and click OK

7. To run the gquery, click the query name in the Nawigaticn Pane on the left side of the screen. You
will see a datasheet displaying records of all the students who live in islamabad as shown in
Fig 8.30. You can also run the query without saving it. After creating the select query, click Run in
the Results group of Design tab on Access Ribbon
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Fig 8 30 List of students hiving n Isiamabad

Creating an Update Query
Update quenes are used o change. add or delete data in existing records. You cannot use an

update query 0 add records 1o or delete records from a table but you use 1t to change existing null
values 1o non-null values and non-null values to null values

We are going to create an update guery that will update the CITY field of all the records that have
the data ISLAMABAD in the STUDENT table tc LAHORE. The easiest way 10 create an update query i1s
to first create a select query and then convert it Into an update query

Steps to create update query
The following are the steps (o Creale update query

1. First create the select query with the critena ISLAMABAD in the CITY column
2. On the Design tab in the Query Type group as shown n F1g.8.31 click Update
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Fig 8.51

3. Access wiil add the Update To row in the query design gnd as shown in Fig.8.32 Type LAHORE
in the CITY column in the Update To row

4. Click the Save icon on the top left corner of the screen.

5. Type a name for the query and click OK

- - - - L - — — o
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6. Double click the query in the Navigation Pane to see the result
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Fig 8 32 Query Design grid for ¢reating Update Query

Creating a Delete Query
Delete queries are used to deleta entire records from tables along with the primary key. The process

of creating a delete query using query design window I1s very similar to creating update query. To do
this. first create a select query to select the records that you want to delete and then conven it into a

delete query

Suppose in cur Student Database Management System we want to delete records of all the
students of class XI-B
The following are the steps to create this query

1. First create the select query with the criteria XI-8 in the CITY column

2. On the Design tab in the Query Type group shown in Fig 8 33, click Delete This will hide the
Show row in the Jower section of tne desgn gnd and add the Delete row
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Fig 8.33 Creating a delete query
3. To delete the selected records. chick Run in the Results group of Design tab. Access will ask you

to confirm your action, click Yes to confirm
To delete related data in tables, getermine which records are on the “one” side of the relationship

and which on the "many"” side If you want.to delete records on the “one” side of the relationship and
the records on the "many” side, you mus! enable Referential integrity and cascading delete If you need
to delete records oniy on the "one” sice of the relationship, you first delete that relationship and then
delete the data If you need ¢ delete records only on the many side cof the relationship. you can create

and run your deilete query without having {0 change the reiationship

Creating an Append Query |
Append query is used to add recoerds from a mere source table 10 a destination table. Very often, the

source anc destination tables are in the same database Append queries are not usec 10 change the
gata n individual hields »n existing tables For this, we use update query. When appending reccrds in
table, make sure that the data types you set for the fields in the source table are compatible with the

data types that you sel for the 1abie fields in the destination table
An easy way 10 create an append query I1s firs! create the select query and then convert it into an
append query as we did for creating an update and delete query

The following are the steps o create an append query to append records of students of any section of
class X!I to a table in another database

1. Open the database that contains the records that you want to append
2. Click the Create tab and click Query Design to bring up the query design window
3. Select the table that contains the records that you want to append and ciick Add and then chck

Close

4. Double click the fields that you want 10 append so that they appear in the Field row on the design
g

5. Enter the criteria Like “XII-7" in CLASS column as shown in Fig 8 34 The criteria will find all the
records that contain a 5 letter string in which the first 4 letters are "XII-" and the last letter is
unknown for any section of class Xl|
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Fig 8.34 Query design gnd showing append critena
6. Click Append in the Query Type group of Design tab shown in Fig.8.35

) o e 4

' Lo Daly Ontadast | ran Orrvn
F'_""ﬁ :

"ol O~ ::,,,w

Moty LedMes Ly Dy
'u;. d :‘“.‘ 0" "."'

Fig 8 35 Selecting query type from Design tab
7. The Append dialog box shown in Fig 8 36 will appear Enter the table name in which you want 1o

append the records. Choose to append records to another database and enter the file name and
then click the OK button .

e = e - - -

Fig 8.36 Append dialog box for appending records.

Creating a Make Table Query |

A make table query retneves records from a table and copies them into a new table. The new table
can be in the database that you have open or you can create it in another database. To create a make
table query, first create a select query and then convert it into 38 make table query. Choose a location
for the new table and then run the guery 10 create the new lable

The following are the steps 10 copy all the records of students having the data ISLAMABAD in the CITY
column of STUDENT table

1. First create a select query that has the cntena ISLAMABAD in the CITY field column in the query
design gnd

2. Make Table n the Query Type group of Design tab. The Make Table dialcg box will appear as
shown in Fig.8 37
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Fig 8 37 Make Tabie dialog box

3. If you want to place the new table in the current database, select Current Database otherwise .act
Another Database and enter the location and the file name of the other database.

4. Cick OK,
5. Chick Run in the Results group of Design tab.
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)===1AB ACTIVITIES

Following lab activities are to be carried out during the practical periods.

A:;|> Students should know how to launch Access and create and save a database.
‘wer

Practical Work

2) Creation of following database objects should be demonstrated on the computer:
» Table

» Form
» Query

» Report
Answer

Practical Work
3) Following operations should be performed on the computer.
» Entering, deleting and modifying of data in records
» Filtering records
» Sorting records

» Searching records
Answer
Practical Work

4) Creating and editing relationships between tables.
Answer
Practical Work

>) Formatting and printing forms and reports,
Answer
Practical Work
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